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Pentahc
OLAP Schema creation in Pentaho in detc
Dynamic Security in Pentaho OLAP

MDX in action

Pentaho Reporting in detail (PRD and PME)
Analysis Report

Dashboard (EE and CDE)

Infroduction to Pentaho Big Data Ecosystem




Other breaks as needed






» Pentahc
» Pentaho Report Designer
» Pentaho Metadata Editor



£ Pentaho BI Suite Enterprise Edition j‘
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» Execute/Viey

» Manage Data Sources
» Manages Schedules

» Facilitates Self-Service Analysis/Reporting/Dashboard creation




» Plugin Based architecture

» Easy to develop and deploy ETL flows



» Developec

» Can create pixel perfect reports



» Metadata Moo
» Metadata Model Integrates with BA Serve
» MQL is used for data retrieval



» Supports Star and Snow

\_ —

» Role based access conirol



» Very

\J | T

» Connects to various Data Sources i



DIMENSION MOL
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» MDX is the language that talks to Mc

» Pivoting can be done using client tools like Analyzer
» Operations supported : Roll up, Drill Down, Slice and Dice.



» Main Data Storage syste

» Mainly used for Reporting and Analysis
» Separate from Transaction Database
» Central repository for Integrated data from various sources



OLAP Analysis

Canned Reports

Dashboards

Any Client

Source N




» Subject Spe

» Smallerin size

=0
Data Sources -

Data Warehouse

<IN
Data Marts



Dimension are Conte at de
» Dimensions have group of hierarchies
» Shared Dimension (Conformed)

» Degenerated Dimension

» Additive, Semi-Additive and Non-Additive Facts

» Factless Fact



» Sub

@, O
» Private Schedule creation (access based

» Self Service Report Creation (access based)

» BA Server Administration
» User and Role Management
» System Setting
» Access Confrol
» Public Schedule creation
» Repository and other Cache Refresh

» Many more...






» Versioning
» Scheduling
» Real-Time Monitoring

» Access Control



Flexibility:
Never forces a certain path on the use
Pluggable architecture for extending functionality

Modern standards-based architecture
100% Java with broad, cross-platform support
Over 100 out-of-the-box mapping objects (steps and job entries)

Enterprise class performance and scalability

Lower total cost of ownership (TCO)
Lesser license fees
Short implementation cycles
Reduced maintenance costs



- OLAP Analysis

Canned Reports

Dashboards

Un-Structured Data |
Any Client



» ODJe c
» Connections
» Transformation
» Job

» Schema

» Components:
» Spoon
» Pan
» Kitchen

» Carte



» Main Tree (Desic
» Run and Preview
» Execution Results

» Debugging



» repositories.xml: Loc

» db.cache: database cache for metadato
» .spoonrc: User Interface setting, last opened kirs/kjbs
» languageChoice: User Language



v

» Hops — Connector for various steps fc
Metadata flow

» All the steps are initialized at once. Sequence not predictable.

» Processes the data as a stream. Can process unlimited no. of rows



» ODB
» JNDI
» Driver jaris required in case of JDBC connection

» Database can be explored from the Ul



Table Input
» Excel Input
» Generate Rows

» Get System Info
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» Excel Output
» XML Output
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Add Constants
Add Sequence, Add value fields changing seque
Sort Rows

String Operations, String Cut

Unique Rows



red OC

Merge Join
» Database join

» Dimension Lookup/Update
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» Group by
» Merge Rows

» Unique Rows



INTRODUCTION TO JOBS

» Jobs aggregate individual pieces of functionality
to implement an entire process.

» Manages the Work-flow of the ETL process
» Hops Types

» Uncondifional

» Success — True Condifion

» Failure — False Condition

» Job Enfries can be Job Entries, Transformations or
another Job

» A Job starts with the START button
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ael 3 FilE*ith FTP

TransFormation
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Job entries



» She
» Conditions — Checks or Evaluates so .

» Check DB Connection, Table Exists, Column Exists

» Simple Evaluation

» Check Folderis empty, File is locked, Check if files Exists, File Exists
» Utility — Some utilities for doing some tasks.

» Abort Job

» Ping a host, Telnet a host

» Truncate table
» Write to log
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» File Transfer — Move/Copies files fro
» Get and Put File with FTP
» Get and Put File with SFTP
» Get and Put File with FTPS



» Parameters

» Parameters are like local variables; they are reusable inpu
transformation that they are defined in. When defining a parameter, you can assign
default value to use In the event that one is not fetched for it.

» Variables

» Avariable in PDI is a piece of user-supplied information that can be used dynamically and
programmatically in a variety of different scopes.

» PDI variables can be used in steps in both jobs and transformations






» Supports aggrec
data from standard relational databc
MySQL, Microsoft SQL Server, IBM DB2, and others.

» Automated Optimizations

» Pre-compiled MDX expressions allow Mondrian server to
optimize queries, choosing between evaluating an
expression in memory and pushing the query to the
RDBMS.

» XML based cube schema
» Aggregate Aware
» Role Enabled



MONDRIAN AT WORK

A dimensional model (logical)
» Cubes & virtual cubes
» Shared & private dimensions

» Calculated measures in cube and
in query language

» Parent-child hierarchies

... mapped onto a star/snowflake
schema (physical)

» Fact table
» Dimension tables

» Joined by foreign key relationships

Product —a=

Geography —w=




MOoves

movementfact
Terminal terminal_id
Terminal terminal_id

<Level name=" terminaldim terminal_nam

</Hierarchy>
</Dimension>
<Measure name="* " column=" “aggregator="sum" formatString="####"/>
<Measure name="* " column=* “aggregator="sum" formatString="####"/>
<CalculatedMember name=* “ dimension=" >

<Formula>

</Formula>
</CalculatedMember>

</Cube>



» Mulfidimer

QINL®

» A cube is a collection of measures and d
» There can be n dimensions
» Measures evaluated at the intersection of all n dimensions

» Cubes can be sparse (minimal intersections) or dense (many
intersections)

» Cubes also allow aggregation along dimensional hierarchies
» Enables rapid drill-up/down

» More flexible than table based consfruct




DIMENSIONS AND MEASURES

Cubes can have more than two ““":_mf

Africa

The cube shown in the diagram has
four dimensions:

\‘ Europa

represent the data Western =ric
g 5 0 Hemisphers

organized by other dimensions

included in the cube.

15t half 2nd half
[ ——

The cube shown in the diagram has
two measures, and

—— Dimension
— > Measure

43




</Level>
</Hierarchy>
</Dimension>
<Measure/>
<CalculatedMember/>
</Cube>

» It is possible to map to snowflake and similar relational structures.

» For complete schema reference: IC


http://mondrian.pentaho.com/documentation/schema.php

» If a dimension is in the fact table (or, more
dimension being accessed is in the fact table), Mondrian doe
perform a join.

» If two dimensions access the same table via the same join path,
Mondrian only joins them once.



SCHEMA WORKBENCH

» This is The tool to build and test the Mondrian schema

Schema - MNew Schemal (workbench.xml)

— Schema
v @ Current Issues
Table: fact_issue_change Net{)pen
aggregamr sum
column M_NETOPEN
formatString

visible v

datatype Numeric
formatter

O O O MDX Query - connected to workbench.xml

select {[ Measures] .[ NetOpen] } ON COLUMNS,
{[ Time] .[ Bl1 Time]} ON ROWS
from [ Current Issues]

{[ Measures] .[ NetOpen] }
|;| Database - software_ga_rpt (M Rxis #2:
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Add Named Set
Add User Defined Function
» Add Calculated Member
» Add Measure

» Add Level

» Add Property

» Add Virtual Cube

» Add Virtfual Dimension

» Add Virtual Measure




» Mus
setup

» Select a “schema”

» Listis the Schemas windows
that are currently open in the
application

» Connect to verify the
Schema/connection

» Top Window
» Enter in an MDX query
» Bottom Window

» Review your results after hitting
Execute

» NOTE: Format is a text printout,
NOT a crosstab

™ O O MDX Query - connected to workbench.xmi

r,

Schema 2 workbench.xml | & ._ ( Connect )

select |[[ Measures] .[ NetOpen] } ON COLUMNS,

{[ Time.Time] .[ A1l Time] }
How #0: 1,909

Execute



| 2 IS WAS €

» MDX is used o
» Query a multi-dimensional data source to return values.
» Navigate the structure of an OLAP data source (cube).

» Obtain information about dimension hierarchy and its

members.

» Create a calculated member via MDX expressions.



» WHERE clause (slicer).

» A basic MDX query looks like this:

SELECT {([Measures].[sales], [Measures].[profit])} ON COLUMNS, {([Region],
[product])} ON ROWS
FROM [salescube]
WHERE ( [Time].[2016] )

» Mondrian specific MDX documentation is here:


http://mondrian.pentaho.com/documentation/mdx.php

» Sets are orderec
» Sets are enclosed by {}

» All Tuples in a set must have the same dimensionality
» A set can contain a single tuple

» Example Set: Profit for 2016 and 2015
» {(Time.[2016], Profit) , (Time.[2015], Profit)}

» For those interested in more detailed MDX reference, check out this site:

>



http://msdn.microsoft.com/library/default.asp?url=/library/en-us/olapdmad/agmdxbasics_04qg.asp
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children of the <Schema> ¢

< name="“South Manager"™>
< access="none">
< cube="sales" access="all">
< hierarchy="[Region]" access="custom"
topLevel="[Region].[Territory]* bottomLevel="[Region].[Territory].[State].[City]* >
< member="[Region].[South Region]" access="all"/>
</ >
</ >
</ >
</ >

» The above example restricts South Manager to seeing only South in
the Sales cube


../../../../../../../../../pentaho/kettle/BasicStudies/IntroToMondrian/FullMondrian.html#XML_Role
../../../../../../../../../pentaho/kettle/BasicStudies/IntroToMondrian/FullMondrian.html#XML_SchemaGrant
../../../../../../../../../pentaho/kettle/BasicStudies/IntroToMondrian/FullMondrian.html#XML_CubeGrant
../../../../../../../../../pentaho/kettle/BasicStudies/IntroToMondrian/FullMondrian.html#XML_HierarchyGrant
../../../../../../../../../pentaho/kettle/BasicStudies/IntroToMondrian/FullMondrian.html#XML_MemberGrant
../../../../../../../../../pentaho/kettle/BasicStudies/IntroToMondrian/FullMondrian.html#XML_HierarchyGrant
../../../../../../../../../pentaho/kettle/BasicStudies/IntroToMondrian/FullMondrian.html#XML_CubeGrant
../../../../../../../../../pentaho/kettle/BasicStudies/IntroToMondrian/FullMondrian.html#XML_SchemaGrant
../../../../../../../../../pentaho/kettle/BasicStudies/IntroToMondrian/FullMondrian.html#XML_Role

< »

> DIE O
» <SchemaGrant access="none
» <CubeGrant cube="Sales" access="all">
» <HierarchyGrant hierarchy="[Store]" access="custom" topLevel="[Store].[Store Cou
» <MemberGrant member="[Store].[USA].[CA]" access="all'/>
» <MemberGrant member="[Store].[USA].[CA].[Los Angeles]" access="none"/>
» </HierarchyGrant>

» <HierarchyGrant hierarchy="[Customers]" access="custom" topLevel="[Customers].[State Province]"
bottomLevel="[Customers].[City]">

» <MemberGrant member="[Customers].[USA].[CA]" access="all"/>
» <MemberGrant member="[Customers].[USA].[CA].[Los Anhgeles]"access="none"/>
» </HierarchyGrant>
» <HierarchyGrant hierarchy="[Gender]" access="none"/>
» </CubeGrant>
» </SchemaGrant>
» </Role>



» More detaqils © o
following locations:

>

| 4
go to Analyzer Data Multi-Tenancy section for more details.


http://mondrian.pentaho.com/documentation/schema.php#Schema_processor
http://help.pentaho.com/Documentation/6.1/0R0/070/Multi-Tenancy

» Hierarchy

» Member

» Establishing access defaults at higher levels and overriding those
defaults among the lower levels



» This default access

@ Olw

Schema.

» A <CubeGrant> defines the default access to a particular cube
within the Schema.

» The access attribute can be "all" or "none".

» The access can be overridden by Hierarchies in the Cube.



» "'custom”, enables ¢

» “toplevel” can be set to identify the highest level ©
aggregation that the user can access (preventing view of “big picture

» “bottomLevel” can be set to identify the lowest level of member detail
that the user can access (preventing view of “private details” )

» <MemberGrant> elements may be nested to identify member specific
access within the Hierarchy



» Grants are order-dependent.

» If you grant access to a parent, then deny access to one of the children,
then you will be able to see all other children except the one that was

denied.

» If you deny access to one of the children, then grant access to the parent,
you would override and have access to the child.

» A member is visible if any of its children are visible.

» Suppose you deny access to a parent, then grant access to one of its
children, then you would override and gain access to the parent summary
but none of the detailed siblings of the child.

» Member grants don't override the hierarchy grant's top- and bottom-levels.




every cube |
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» Most databases associate roles (or 'groups’) with users, ano
automatically assign them when users log in.

» However, Mondrian does not have the notion of users, so you have
to establish the role in a different way.

» Pentaho action sequences and components enable passing of the
Role info the Mondrian server.




com/documentation/aggregate tables.php

» There are certain rules that need to be followed o

PIOI®


http://mondrian.pentaho.com/documentation/aggregate_tables.php

» But, will have the stc

» Cache should be flushed on a regular basis by the

» This can be done from the Pentaho BA server Ul or by calling/scheduling
an xaction.

» The cache can also be cleared programmatically by calling few APIs
exposed by Mondrian.


http://mondrian.pentaho.com/documentation/cache_control.php#CacheControl_API




» Provides crifical functionali
» Web-based Access

Prompting/Parameterized Reports

Scheduling

Subscriptions

Bursting/Distribution

vV v v Vv VY

Graphical Design Tools

» Provides features for developers

» Heterogeneous Data Sources

» Relational, OLAP (Mondrian), XML, custom and Pentaho Data
Integration Transformations

» Modular Report Definition
» Separates presentation from query
» Integration points to applications, portals
» JSP, Portlet, Web Service



» Access relational, OLAP, or XML dc

» Conditional hiding of report objects

» Embeddable

» Lightweight

» Easy tfo extend
» 100% Java - Portability, scalability, integration

» Cross Platform (client and server) - Mac, Linux/Unix, Windows

» Multiple Output formats — HTML, CSV, PDF, Excel and Word




Data Source PRD Engine Report-
(Any) Definition

|




BUI

» Scheduled/Subscribed

>



Rectangles (used for row o
Bands (group of objects)
Lines

Images

Charts

Calculated Fields (Functions/Expressions)

Custom Calculated Fields (BeanShell Expression)




REPORT SECTIONS




PRD LAYOUT

Pentaho Report Desi Q@
- ]

100 150 250 oo o 350 0 400 0 450 ¢ 500

Structure

Palette Toolwindow
Toolwindow

Report Definition
Area =

Properties
Toolwindow

Messages
Toolwindow

LI mar



» Report

This is the master node that
will have all the elements
present in the report.

'Eg Skruckure

I}ij Diata Sefs
,ﬂ:u Fepart Funckions
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» Data Sets

----- | Report Header

: Any dataset that is added

E*E Item Band to the report will be present /
- Feport Fooker here.

- Page Footer /
..... E= Mo Data Band » Report Functions

| Watermark Functions that can be used
' on the elements are listed
under this.

A~ N
-4 5 Groups



» Page Header Band

g0 180 o 2000 0 2 0 3

The content in this band will be
present in each of the output
pages of the report. This can
be configured to print only on

Page Header

the 15" and the last page.

» Report Header Band
After the page header, this will
be printed only once; at the
beginning of the report.
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Iten Band
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» Report Footer Band

Itenn B: E,

If not empty, the content of
this section will be printed at
the end of the report just
before the page footer.
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» Page Footer Band

The page footer band, when
not empty, is printed at the
bottom of each page. This
can be configured to print
only on the 15" and the last

page.




80 o100 150 o 2000 o 2800 . 300 o 350 400 0 450 o 500

» ltem Band

This section will have the
data to be displayed by the
Data set queries. Only one
Query can be called in this

section at a fime. /
» Watermark Band
The watermark band is

printed on the background
of every page.
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» Groups

This band will have the
group and sub-group’s
details. All the groups will
appear here.

» NoData Band

The content of this band
will be displayed when no
Data is returned from the
Data —set queries.



» PDI tfransformations — o
connect tfo a lot more Data Sources.

» Pentaho OLAP Schema - The OLAP schema along with a database
connection can act as a source for the Report.

» Pentaho Metadata Model — The Metadata model can be used as a
source for the report.




>

» Report Functions can be used to:

>

>
>
>

>

u

F?rr)no’r report content (row banding, remove dups, conditic
etc

Add hyperlinks
Generate row level calculations

Colc)ulo’re group and report level aggregations (e.g. sum, average, min,
MaX

Add and format charts

» Functions can be added usin? the Data tab by selecting the
U

Functions node. All available

nctions are listed in the Add Function

window.

» It can also be added to a particular element by using the + on the
right side of the element.



Function Class Description

CreateHyperLinksFunction

a spe

TextFormatExpression Uses a java.text.MessageFormat to concatenate and format W

from an expression, function or report data source.



i@ C

giving it a meaningful No s

dynamically determined based on report fields, use

refer o them using the {<n>} variable replacement syntax. <n>
refers to the number of the variable field specified starting with O
for the first field.

Create a CreateHyperLinksFunction report function whose
element is named the same as your field element name (e.g.
URLFIELD) and whose field is named the same as your
TextFormatExpression (e.g. URLTEXT).



press the Delete ke

» When you expand the group in the Structure toc
see that there is also a group header band and a group footer banc
available.

» Each time a new group starts, the group header band of this group is
prinfed. Whenever a group ends, the group footer band is printed.

» Subgroups are nested within their parents. You must expand the
parent to see the children.

» Group header and footer bands do not appear in the graphical
report definition area unless you make them appear by selecting the
bands in the Structure tool-window and furning the Show In Layout
GUI property on.



> U
» Change what data is provided 1o

» Report Behaviour Parameters can...
» Change how report functions operate, thus
» changing what elements are displayed and/or
» changing the display format of elements and/or
» changing the formulas by which fields are calculated and/or

» eic...



HOW TO DO IT¢

» Configure the Parameter: DEE®(8]> % 4 ® muramee.
= <Untitled Report>{X] B4 e
DataSources
o T
100% /10 | || TBC ReportCom) hEez
B W uery 1 Label (= | JDBC: ReportConn

o Query 1
Page Header |~ Valuz Type String fi Functions

» Add a Parameter from the Data
Tab in the report.

» Add/Use the Datasource.

» Select the appropriate options for
the parameter.

Data Format

Default Value

. @ [[]Mandatory
» The above defined parameter it
can be passed on to the main

query to filter the dataset.

textfield
Prompt
Display Type Drop Down

Query Query 1

Value Customernumber

» Use the parameter in the query
like the following example:

Display Mame Customername
Report Footer ::1' Display Value Formula
; [] Vaiidate Values
[ Reset to default value on invalid selections

Select productname, city, amount
from sales

[ Use first value if default value formula results in NA.

Page Footer _

where customernumber =
${Param1}
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> YU repo
therefore you must create

\ U/ -

» It can make use of the inherited Data sources or can have

W, —

» It can also be parameterized as the main report. The only difference
s, It needs to import the parameter from the “Master” report.



Centralized maintenc

» Can be edited by client tools

» Available to enfire solution

» Changes reflected at runtime
» Intfegratfion with existing metadata systems
» Security enforced at content design time and runtime

» Embeddable and Extendible
» Metadata can be queried programmatically
» Also exists as an embeddable Java component

» Open and extendible architecture



Steel &Wheels

Metadata Editor
(C“en” PenTOhO BA Sel’vel’ e

JDBC

Database



» Can be view

» Each solution is restricted to have at most one domain
» Remember: solution repository can have multiple solutions
» Domain must be published as file metadata.xmi to the solution root

» Metadata editor only works with a domain at time

» Examples:

» “Sales” domain to define the relationships and entities used by sales tfeam



» Physical Table

» Represents an actual table in the database

» Associated with exactly one connection

» Physical Column
» Maps to an actual column of a table in the database

» Associated with exactly one physical table



» Business Model
» Logical parallel to the physical connection; mapped to a single connection

» Contains the business tables, business columns, and business relationships

» Business Table and Business Column
» Logical mapping of physical table and physical column

» Minimize impact of changes in physical table\physical column



U U

» A logical grouping of business colu

» Members of category can come from different business tables of sc
model

» Example: Customer category could contain customer name, address,
customer ID, credit rating, etc. (all from different tables)

» Business View
» Collection of business categories
» Each business model contains a single view

» Business user’s “view" of model



Business

a

/

/

Business Category

rder Tota
Order Date \

~

Physical

Business Column '
)




» Publishes metadatc

» Interfaces with the Pentaho Bl Platform\Se
» Requires a JDBC connection to the data
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» Right- .

» Right-click on existing physical table
Physical Columns

» Contained as “children” of physical table; deleted with physical table
» Must exist in database or be calculations

» All physical column management done in physical table property editor

Creating and configuring a Business Model

Creating and Managing Business Tables and Columns
Defining relationship between the Business Tables
Managing Business Categories

Save and Publish to the Pentaho BA Server



COMPLETED MODEL

@Pentahn Metadata Editor - Pentaho Samples - |O] %]

There are 3 business models available.
Select one of them in the tree to view.




